Laporan Tugas Akhir

BAB II
TEORI DASAR


Pada bab ini dibahas tentang teori gerak, teknik instrumentasi, komponen elektronika, mikrokontroler ATMega 8535, dan program AVR.

2.1 Gerak

Gerak adalah perubahan kedudukan atau posisi benda terhadap acuan tertentu. Setiap saat terlihat benda-benda bergerak, di jalan raya banyak mobil yang sedang bergerak, di pusat perbelanjaan banyak orang bergerak melakukan aktivitas, di sungai dapat melihat gerakan aliran air. Bumi selalu dalam keadaan bergerak, yaitu gerak rotasi dan revolusi. Gerak disebabkan oleh beberapa faktor diantaranya, jarak dan perpindahan, serta kecepatan dan kelajuan.

2.1.1 	Jarak Dan Perpindahan

Sebuah benda dikatakan bergerak jika kedudukan benda dalam selang waktu tertentu berubah terhadap suatu titik acuan yang dianggap diam. Berdasarkan definisi di atas titik acuan atau koordinat benda dikatakan diam terhadap kedudukan benda tersebut jika koordinat selalu tetap meskipun ada perubahan waktu. Gerak suatu benda berkaitan erat dengan besaran jarak dan perpindahan.
Jarak adalah panjang lintasan yang ditempuh suatu benda yang bergerak, sedangkan perpindahan adalah perubahan kedudukan atau posisi suatu benda diukur dari posisi awal ke posisi akhir benda atau dengan kata lain jarak hanya memperhitungkan panjang lintasan yang ditempuh dengan tanpa memperhatikan arah, sedangkan perpindahan adalah perubahan posisi atau kedudukan suatu benda dengan memperhatikan arah. Sehingga perpindahan merupakan besaran vektor sedangkan jarak merupakan besaran skalar.


2.1.2 	Kelajuan Dan Kecepatan

Dalam kehidupan sehari-hari, kata kecepatan dan kelajuan sering disama artikan. Kecepatan dan kelajuan merupakan dua pegertian yang berbeda. Kecepatan (velocity) merupakan besaran vektor, yaitu besaran yang memperhitungkan arah geraknya. Kecepatan dapat juga didefinisikan sebagai perbandingan perpindahan benda dengan waktu tempuh. Persamaan kecepatan seperti yang ditunjukan pada persamaan (1).
Kecepatan = 	(1)
Kelajuan (speed) merupakan besaran skalar, yaitu besaran yang hanya memiliki nilai tanpa memperhatikan arah gerak benda. Kelajuan dapat juga didefinisikan jarak tempuh benda dan waktu tempuh yang dibutuhkan untuk menempuh jarak tersebut tanpa memperhatikan arah perpindahan benda. Dimana persamaan kelajuan ditunjukan pada persamaan (2).
Kelajuan =  	(2)
1. Kelajuan Rata-Rata Dan Kecepatan Rata-Rata
Kelajuan rata-rata diperoleh dari jarak yang ditempuh benda dibagi dengan waktu tempuh. Secara matematis, kelajuan rata-rata dituliskan dalam persamaan (3).
v =  	(3)
Keterangan :
v	= kelajuan rata–rata (ms-1).
s	= jarak tempuh (meter).
t	= waktu (sekon).
Berbeda dengan kelajuan rata–rata, kecepatan bergantung pada perpindahan dan waktu yang dibutuhkan untuk melakukan perpindahan. Secara matematis, kecepatan rata–rata dituliskan dalam persamaan (4).
v = 	(4)
Keterangan :
v	= Kecepatan rata–rata (ms-1).
𝚫x	= xakhir – xawal = perpindahan (meter).
𝚫t	= Selang waktu (sekon).
2. Kelajuan Sesaat Dan Kecepatan Sesaat
Kelajuan sesaat adalah kelajuan pada suatu waktu tertentu atau kelajuan pada suatu titik dari lintasannya. Jika selang waktu 𝚫t diperkecil terus menerus sehingga titik B mendekati titik A,  mendekati suatu nilai tertentu. Pada saat selang waktu Dt mendekati nol, harga disebut kelajuan sesaat (v) di titik A. Besar kelajuan sesaat dapat ditulis berdasarkan persamaan (5).
v = , untuk mendekati 𝚫t = 0 	(5)
Persamaan yang sama juga digunakan untuk menentukan kecepatan sesaat. Perbedaannya kecepatan sesaat harus disertai dengan arah gerak benda. Grafik kedudukan Vs waktu dapat dilihat pada gambar 2.1.
.
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Gambar 2.1 Grafik Kedudukan Vs Waktu

2.2 Teknik Instrumentasi

Teknik instrumentasi adalah peralatan yang digunakan untuk pengukuran dan pengendalian suatu sistem. Sistem instrumentasi merupakan gabungan dari beberapa peralatan. Secara umum, sistem instrumentasi terdiri dari empat elemen dasar, yaitu peralatan masukan (input), pengkondisi sinyal (sinyal conditioning), sistem pengolah, dan peralatan pencatat.
Peralatan masukan (input) merupakan peralatan pertama yang menerima besaran yang akan diukur. Output yang dihasilkan dari peralatan masukan berupa sinyal-sinyal listrik. Peralatan masukan (input) terdiri dari dua komponen, yaitu sensor dan transducer. Sensor merupakan bagian perangkat yang mendeteksi variabel fisik suatu media yang sedang diukur. Transducer merupakan bagian perangkat pengukur yang mengubah variabel yang terukur menjadi variabel dalam bentuk lain misalnya tegangan. Sensor dan transducer harus memiliki karakteristik sebagai berikut :
1. Ketelitian yang tinggi.
2. Ketepatan yang tinggi.
3. Jangkauan pengukuran yang lebar.
4. Kecepatan respons yang tinggi.
5. Mudah untuk dikalibrasi.
6. Keandalan tinggi.
Pengkondisi sinyal merupakan peralatan yang berfungsi untuk menerima sinyal yang dihasilkan dari peralatan masukan (input) dimana sinyal tersebut akan diperkuat. Sistem pengolah adalah peralatan yang berfungsi mengolah hasil penguatan sinyal oleh pengkondisi sinyal. Peralatan pencatat merupakan peralatan yang berfungsi mencatat dan menampilkan hasil pengolahan dari sistem pengolah agar dapat diamati oleh pengamat. Peralatan pencatat terdiri dari pencatat dengan gerak relatif dan pencatat dengan hasil digital. Skema sistem instrumentasi dapat dilihat pada gambar 2.2.
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Gambar 2.2 Skema Sistem Instrumentasi


2.3 Komponen Elektronika

Komponen elektronika yang dipakai dalam tugas akhir ini adalah LED (Light Emitting Diode)  dan IR LED (Infra Red Light Emitting Diode), Phototransistor, Resistor, Multiturn, IC LM 324N, LCD (Liquid Crystal Display), dan Mikrokontroller ATMega8535.

2.3.1 LED (Light Emitting Diode) Dan IR LED (Infra Red Light Emitting
Diode)

Light Emitting Dioda (LED) merupakan komponen elektronik yang dapat memancarkan cahaya ketika dilalui arus listrik pada kedua kutubnya. Arus listrik mengalir dari kutub positif (anoda) menuju kutub negatif (katoda). LED merupakan produk temuan lain setelah dioda. Strukturnya juga sama dengan dioda, tetapi belakangan ditemukan bahwa elektron yang mengalir ke sambungan P-N juga melepaskan energi berupa energi panas dan energi cahaya. LED dibuat agar lebih efisien jika mengeluarkan cahaya. Untuk mendapatkan emisi cahaya pada Semi konduktor. Skematik LED dapat dilihat pada gambar 2.3.
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Gambar 2.3 Bentuk LED Dan Skematik

IR LED (Infra Red Light Emitting Diode) merupakan salah satu jenis LED yang dapat memancarkan sinar frekwensi lebih rendah dari sinar merah. Cahaya yang dihasilkan IR LED ini sebanding dengan arus forward bias, cahaya yang dipancarkan termasuk infra merah. Cahaya infra merah tidak dapat menembus materi yang tidak tembus pandang. Cahaya yang dipancarkan oleh IR LED tidak dapat dilihat oleh mata manusia sehingga diperlukan phototransistor untuk mendeteksinya.
IR LED yang digunakan harus disambungkan dengan resistor secara serial untuk membatasi arus yang mengalir. Bila arus yang mengalir terlalu besar maka mengakibatkan IR LED terbakar. Bentuk dan simbol IR LED dapat dilihat pada gambar 2.4.
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Gambar 2.4  Bentuk IR LED dan Skematik

IR LED memiliki dua kaki yaitu anoda dan katoda. Kaki anoda pada IR LED memiliki ukuran kaki lebih panjang dibandingkan kaki katoda. IR LED akan berfungsi dengan baik jika kaki-kaki IR LED dipasang dengan benar. Kaki anoda dipasang pada bagian positif (+) dan kaki katoda dipasang pada bagian negatif (-).

2.3.2 Phototransistor

Phototransistor merupakan komponen elektronik sejenis transistor yang tidak mempunyai kaki basis. Kaki basis pada phototransistor diganti dengan material yang dapat menerima dan mengubah energi cahaya menjadi energi listrik. Jika phototransistor menerima cahaya, maka energi cahaya diterima kaki basis akan diubah menjadi energi potensial. Jika kaki emittor dihubungkan dengan ground maka akan mengalir dari kaki basis ke kaki emittor, akibatnya kaki kolektor dan kaki emittor terhubung. Bentuk dan simbol phototransistor dapat dilihat pada gambar 2.5.
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Gambar 2.5 Bentuk Phototransistor Dan Skematik

2.3.3 Resistor

Resistor adalah komponen elektronik yang digunakan untuk membatasi aliran arus listrik. Besarnya nilai tahanan dinyatakan dengan satuan ohm dilambangkan dengan Ω. Nilai tahanan resistor dilambangkan dengan rangkaian warna yang terdapat pada badan resistor. Skematik resistor dapat dilihat pada gambar 2.6.
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Gambar 2.6 Resistor Dan Skematik

2.3.4 Multiturn

Multiturn adalah resistor yang nilai resistansinya dapat dibuah secara langsung baik dengan tuas yang telah tersedia atau menggunakan obeng. Ada dua jenis resistor variabel, yaitu trimpot (trimer potensio) dan potensiometer.
Trimpot (trimer potensio) merupakan resistor yang nilai resistansinya dapat diubah dengan memutar porosnya menggunakan obeng. Nilai resistansi dari trimpot tertulis pada badan trimpot tersebut menggunakan kode angka. Nilai yang tertulis pada badan trimpot merupakan nilai maksimum dari resistansi trimpot tersebut. Misal trimpot dengan nilai 10 KOhm maka trimpot tersebut dapat diubah nilai resistansinya dari 0 Ohm sampai 10 KOhm. Aplikasi dari trimpot dapat kita temui pada rangkaian elektronika seperti receiver atau multivibrator variabel. Jenis-jenis mulititurn trimport dapat dilihat pada gambar 2.7.
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Gambar 2.7 Trimpot

Potensiometer merupakan resistor yang nilai resistansinya dapat diubah-ubah dengan cara memutar porosnya melalui tuas yang telah tersedia. Nilai resistansi potensiometer tertulis pada badan potensio menggunakan kode angka. Nilai resistansi potensiometer yang ada dipasaran ada dua macam, yaitu nilai resistansi yang dapat diubah secara logaritmis dan nilai resistansi yang dapat diubah secara linier. Nilai resistansi yang tertulis di badan potensiometer bermakna sama dengan nilai resistansi trimpot, yaitu nilai yang tertulis dibadan potensiometer merupakan nilai maksimal resistansi yang dapat diatur oleh potensiometer. Aplikasi potensiometer digunakan pada perangkat audio, seperti pada pengatur nada bass, trebel dan volume. Bentuk fisik potensiometer dapat dilihata pada gambar 2.6.
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Gambar 2.8 Potensiometer
2.3.5  IC LM324N

IC LM324N merupakan komponen elektronika yang dapat digunakan sebagai penguat tegangan atau penguat sinyal atau sebagai amplifier. IC LM324N umumnya dikenal dengan Op Amp (Operational Amplifier). Op Amp mempunyai dua kaki input yaitu inverting input (simbol negatif) dan non-inverting input (simbol positif). Sinyal dari kedua kaki input Op Amp ini dapat diolah menjadi data output yang berbeda-beda sesuai dengan fungsi Op Amp yang dijalankan. Salah satu fungsi Op Amp adalah sebagai komparator. Komparator berfungsi untuk membandingkan tegangan yang masuk pada kedua kaki input Op Amp. Bentuk fisik dan simbol IC LM324N dapat dilihat pada gambar 2.9.
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Gambar 2.9 IC LM324N

Untuk membandingkan kedua kaki input pada Op Amp, salah satu kaki input diberi tegangan referensi dan kaki lainnya diberi tegangan pembanding. Salah satu keunggulan LM324N adalah dapat beroperasi pada voltase 3.0 V sampai 32.0 V. Skematik Op Amp sebagai komparator dapat dilihat pada gambar 2.10.
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[image: ]Gambar 2.10 Op Amp Sebagai Komparator
Salah satu fungsi Op Amp lainnya adalah sebagai diferensial amplifier. Diferensial amplifier berfungsi sebagai penguat perbedaan tegangan yang masuk pada kedua kaki input Op Amp. Skematik Op Amp sebagai diferensial amplifier dapat dilihat pada gambar 2.11.
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Gambar 2.11 Op Amp Sebagai Diferensial Amplifier

Nilai tegangan output pada Op Amp sebagai deferensial amplifier dapat diketahui dengan menggunakan persamaan:
 	(6)
Keterangan :	
Vout 		= Tegangan output (Volt).
Vref 		= Tegangan referensi (Volt).
Vin 		= Tegangan input (Volt).
R1 = R2 	= Tahanan (Ohm).

2.3.6 LCD (Liquid Crystal Display)

LCD (Liquid Crystal Display) adalah suatu jenis media tampil yang menggunakan kristal cair sebagai penampil utama. LCD sudah digunakan diberbagai bidang misalnya alal–alat elektronik seperti televisi, kalkulator, ataupun layar komputer. LCD yang digunakan dalam prinsip awal pengukuran gerak pellet senapan angin ini adalah tipe LCD dot matrik dengan jumlah karakter 16*2. LCD sangat berfungsi sebagai penampil yang nantinya akan digunakan untuk menampilkan status kerja alat. Bentuk LCD 16*2 dapat dilihat pada gambar 2.12. Untuk susunan kaki LCD 16*2 dapat dilihat pada tabel 2.1.

Tabel 2.1
Susunan kaki LCD 16*2

	PIN
	Nama Pin
	I/O
	Keterangan
	Hubungan Port Mikrokontroler

	1
	VSS
	Power
	0V
	Ground

	2
	VDD
	Power
	+5V
	Tegangan 5V

	3
	VO
	Power
	Tegangan kontras LCD
	Keluaran trimpot

	4
	Rs
	Input
	Register select, 0 =
Register perintah, 1=
Register data
	PA0

	5
	R/W
	Input
	Sebagai input, R =1, W = 0, diaktifkan low
	

	6
	E
	Input
	Enable clock LCD, logika 1 setiap kali pengiriman atau pembacaan data
	PA1

	7
	Db0
	I/O
	Data bus 0
	

	8
	Db1
	I/O
	Data bus 1
	

	9
	Db2
	I/O
	Data bus 2
	

	10
	Db3
	I/O
	Data bus 3
	

	11
	Db4
	I/O
	Data bus 4
	PA2

	12
	Db5
	I/O
	Data bus 5
	PA3

	13
	Db6
	I/O
	Data bus 6
	PA4

	14
	DB7
	I/O
	Data bus 7
	PA5

	15
	Anoda
	Power
	Tegangan positif
	

	16
	Katoda
	Power
	Tegangan negatif
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Gambar 2.12 LCD 16*2

2.3.7 Mikrokontroller ATMega 8535

Mikrokontroller merupakan perangkat elektronika yang didalamnya terdapat rangkaian kontrol, mikroprosesor, memori, dan input/output. Mikrokontroller dapat diprogram menggunakan berbagai macam bahasa program. Bahasa program yang biasa digunakan untuk program mikrokontroler diantaranya bahasa assembler, bahasa C, bahasa basic dan lain-lain.
Mikrokontroller biasanya digunakan untuk mengendalikan suatu proses secara otomatis seperti sistem kontrol mesin, remot kontrol, kontrol alat berat dan lain-lain. Dengan menggunakan mikrokontroller sistem kontrol akan menjadi lebih ringkas, lebih mudah dan lebih ekonomis.
Salah satu jenis mikrokontroller yang banyak digunakan untuk aplikasi kontrol adalah ATMega8535. ATMega8535 merupakan salah satu mikrokontroller keluaran Atmel. Atmel adalah salah satu vendor yang bergerak dibidang mikroelektronika. Bentuk dan skema mikrokontroller ATMega8535 dapat dilihat pada gambar 2.13.
ATMega8535 memiliki beberapa fitur yang dapat digunakan untuk aplikasi kontrol. fitur yang dapat digunakan adalah fitur interupsi eksternal dan timer. interupsi eksternal adalah mengalihkan alur eksekusi program dari program utama ke fungsi atau prosedur tertentu yang berkaitan dengan kejadian tersebut. Timer berfungsi untuk megukur selang waktu antara dua kejadian yang tidak bersamaan. Timer dianalogikan sebagai suatu penampung yang diisi dengan suatu pulsa dengan kecepatan pengisian pulsa (frekwensi pengisian pulsa) tertentu.
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Gambar 2.13 Bentuk IC ATMega8535

2.4 CodeVisionAVR

AVRSTUDIO merupakan software khusus untuk bahasa assembly yang mempunyai fungsi sangat lengkap. Software AVRSTUDIO digunakan untuk menulis program, kompilasi, simulasi dan download program ke IC mikrokontroller AVR.
	CodeVisionAVR merupakan software C-cros compiler. Software CodevisionAVR dapat ditulis dalam bahasa C. CodeVisionAVR memiliki IDE (Integrated Development Environtment) yang lengkap. CodeVisionAVR digunakan untuk penulisan program, compile, link, dan pembuatan kode bahasa mesin (assembler).
	Proses download  program ke IC mikrokontroler AVR dapat dilakukan dengan menggunakan system download secara ISP (In-System Programing). ISP mengijinkan memori program untuk diprogram ulang dalam sistem menggunakan hubungan serial SPI.
Langkah-langkah untuk menjalankan program CodeVisionAVR adalah sebagai berikut :
1. Membuka CodeVisionAVR
Langkah untuk membuka CodeVisionAVR dilakukan dengan memilih menu Start Menu → All Program CodeVisionAVR → CodeVisionAVR Compiler.  Setelah langkah tersebut dilakukan pada monitor akan tampil tampilan seperti gambar 2.14.
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Gambar 2.14 Tampilan Awal CodeVisionAVR

2. Membuat project baru
Langkah untuk membuat projaect baru dilakukan dengan memilih menu File → New, kemudian memilih Project → OK. Setelah langkah tersebut dilakukan pada monitor akan tampil dialog Create New File seperti pada gambar 2.15.
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Gambar 2.15 Konfirmasi Membuat Project atau File

Jika tombol OK dipilih maka akan muncul kotak dialog Confirm. Kotak dialog ini menanyakan apakah CodeWizardAVR akan digunakan atau tidak. Jika Codewizard akan digunakan maka tekan tombol YES. Kotak dialog confirm dapat dilihat pada gambar 2.16
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Gambar 2.16 Konfirmasi Penggunaan CodeWizardAVR
3. Melakukan konfigurasi project
Langkah untuk menkonfigurasi project dilakukan dengan memilih tab-tab yang ada pada kotak dialog CodeWizardAVR. Tab-tab yang ada pada kotak dialog CodeWizard terdiri dari tab USART, tab Analog Comperator, tab ADC, tab SPI, tab l2C, tab 1 Wire, tab 2Wire (l2C), tab LCD, tab Bit-Banged, tab Project Information, tab Chip, tab Port, tab External IRQ,dan tab Timer. Sebagian tab-tab dapat pada kotak dialog CodeWizardAVR dilihat pada gambar 2.17.
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Gambar 2.17 Konfigurasi Program Melalui CodeWizardAVR

4. Membuat kode program
Langkah untuk membuat kode program dilakukan dengan membuat file dan menamainya terlebihdahulu, kemudian menyimpannya pada folder yang telah ditentukan. Langkah-langkah pembuatan file dilakukan dengan memilih menu File, Generate, save and Exit, kemudian file source (*.c), file project (*.prj) dan file project codewizard (*.cwp), diberi nama dan disimpan pada folder yang telah ditentukan. Setelah langkah tersebut, pada monitor akan tampil program yang siap diisi oleh program yang dibuat. Form program dapat dilihat pada gambar 2.18.
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Gambar 2.18 Form Program

5. Meng-configure program
Langkah untuk meng-convigurasi program dilakukan dengan memilih menu Project → Configure → AfterBuild → program the Chip → Ok.
6. Meng-compile program
[image: C:\Documents and Settings\Kews_23\Local Settings\Temporary Internet Files\Content.Word\New Picture.bmp]Langkah untuk meng-compile program dilakukan dengan memilih menu Projact | compile atau dengan memilih icon  → Program. Jika penulisan kode program benar, maka akan tampil kotak dialog information. Kotak dialog informatioan dapat dilihat pada gambar 2.19.
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Gambar 2.19 Kotak Dialog Information Configure


2.4.1 Interupsi (Interrupt)
Interupsi adalah fasilitas pada mikrokontroller untuk mengalihkan suatu program utama yang sedang berjalan dengan memprioritaskan program yang diutamakan (program interupsi). Pada saat program utama sedang dikerjakan oleh CPU, program dapat berhenti secara tiba-tiba untuk sementara waktu karena ada perintah lain (interrupt) yang harus dikerjakan terlebih dahulu oleh CPU. Setelah interupsi selesai dikerjakan, program utama akan dilanjutkan. ATMega8535  memiliki 21 sumber interupsi. Sumber interupsi tersebut dapat dilihat pada tabel 2.2.

Tabel 2.2
Interrupt Vektor Pada ATMega8535

	No
Vektor
	Alamat
Program
	Sumber
Interrupt
	Keterangan

	1
	$000(1)
	RESET
	External Pin, Power-on reset, Watchdog Reset, and JTAG AVR Reset

	2
	$002
	INT0
	External Interrupt
Request 0

	3
	$004
	INT1
	External Interrupt
Request 1

	4
	$006
	TIMER2
COMP
	Timer/Counter2
Compare Match

	5
	$008
	TIMER 2 OVF
	Timer/Counter2
Overflow

	6
	$00A
	TIMER1 CAPT
	Timer Counter2 Capture Event

	7
	$00C
	TIMER1
COMPA
	Timer/Counter2 Comparev Match A

	8
	$00E
	TIMER1
COMPB
	Timer/Counter2 Compare Match B

	9
	$010
	Timer1 ovf
	Timer/counter1 overflow

	10
	$012
	TIMER0 OVF
	Timer/Counter0 Overflow

	11
	$014
	SPI,STC
	Serial Transper Complete

	12
	$016
	USART,RXC
	Usart, Rx Complate

	13
	$18
	USART, UDRE
	USART Data Register Empty

	14
	$01A
	USART,TXC
	USART,Tx Complete

	15
	$010C
	ADC
	ADC Conversion Complete



	No
Vektor
	Alamat
Program
	Sumber
Interrupt
	Keterangan

	16
	$01E
	EE_RDY
	EEPROM Ready

	17
	$020
	AN_COMP
	Analog Comparator

	18
	$022
	TWI
	Two-Wire Serial Interface

	19
	$024
	INT2
	External interrupt request 2

	20
	$206
	TIMER0
COMP
	Timer/Counter 0 Compare Match

	21
	$028
	SPM_RDY
	Store Program Memory Ready



2.4.2 Timer

Timer merupakan fasilitas pada mikrokontroller yang digunakan untuk mengukur selang waktu antara dua kejadian yang tidak sama. Timer dianalogikan sebagai penampung yang diisi oleh pulsa dengan kecepatan pengisian pulsa (frekwensi pengisian pulsa) tertentu. Ketika penampung tersebut penuh, penampung akan dikosongkan kembali dan mikrokontroller akan mengeksekusi suatu fungsi yang terkait dengan timer.
Waktu pengisian suatu timer ditentukan oleh kapasitas  timer dan frekwensi pengisian pulsa pada timer. Semakin besar kapasitas timer, semakin lama waktu yang diperlukan untuk mengisi timer dari kondisi kosong sampai kondisi penuh. Semakin besar nilai frekwensi pengisian pulsa pada timer, semakin cepat waktu yang diperlukan untuk mengisi timeer dari kondisi kosong sampai kondisi penuh.
ATMega8535 memiliki fasilitas tiga buah timer, yaitu timer0 (8 bit), timer1 (16 bit), dan timer2 (8 bit). Kapasitas timer (8 bit dan 16 bit) menyatakan jumlah data yang bisa ditampung pada register penampung timer.
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